Library resource and search skills
**Outline**

**Library Service**

- **Research start**
  - Understand citation or bibliography
  - Searching skills
    * E-resources platform
  - Paper collection
    * Interlibrary loan
  - Electronic collection
    - E-books
    - E-journals
    - E-databases
    - Theses
  - Scholarly literature web service
    * Google Scholar/Microsoft Academic
  - Plagiarism detection service
    * Turnitin
Main Library

MON - FRI : 08:20-21:30
(Circulation、Computer area、Interlibrary loan 08:20 – 21:10)
SAT - SUN : 09:20-21:30
(Circulation、Computer area、Interlibrary loan 09:20 – 21:10)

Kun-Yen Medical Library

MON - FRI : 08:20 - 21:30
SAT : 09:00 - 17:00  SUN : 13:00 - 17:00
MON - SUN: 09:00 - 23:00

*Personal reading room, group discussion & interactive area
*NCKU Students and Faculties only

Note:
National holidays and its deferred holidays are not open.
Opening hours for winter or summer vacations will be announced separately.
Access Library

Can

• With valid Students ID, if not, please deposit personal ID and register access at library entrance.
• You are responsible for your belongings at all times.
• Ask others to end conversations, lower their voices, and otherwise maintain an atmosphere that is supportive of scholarship.

Can Not

• Food and drinks are not allowed in all areas of library.
• Help non-NCKU students bring their personal reading materials into the library.

Lockers locates on the 1F, Main library
Using the Library

**Borrowing**

Number of Checkouts Allowed:
- Undergraduates: 30
- Graduate Students: 50

Book Loan Period: 30 days
Renewal: 11*

The following items cannot be renewed:
- Items on hold/recalled,
- an overdue recalled item

Overdue Fines: NTD$ 5 per item per day
No “grace periods” for overdue materials.
Frequency check your email reminder.

**Placing a hold**

Maximum of reserved items: 10

http://www.lib.ncku.edu.tw

Links
- Catalog
- Items Requesting/Renewing
- Personal Data
- Open Hours
- E-Resources
- Media Online
- Library Instruction
- Electronic Thesis
- Service Readers
- Space Management
- NDDS | RapidILL
- MetaCat +
Using the Library

Reserve a Room
Space can be reserved up to 7 days in advance

Group Study Rooms
For 3 or more students in a study group, maximum of 4 hours per day

Individual Study Rooms
For graduate students only

Computers, Printers, Scanners

Computers, Scanners
Online search area, 1F, Main Library
Online search area, 1F, Medical Library

Printers
B2F, 1F, 3F, Main Library
1F, Medical Library

Wireless access & Connect from Off Campus

In campus
NCKU-WLAN-802.1x
NCKU-WLAN

Off campus
NCKU SSL VPN
NCKU-WLAN-802.1x: providing dynamically varying encryption keys for wireless networks.
Start your Research
Find more research methods books

**Searching via Library catalog**

- **Keyword search**

- **Subject search**

**Searching via Library Discovery Service**
### Find more academic writing books

#### Searching Library catalog

<table>
<thead>
<tr>
<th>Title</th>
<th>Analysing structure in academic writing / by Tomoko Sawaki.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Author</td>
<td>Sawaki, Tomoko.</td>
</tr>
</tbody>
</table>

- **Description**: 1 online resource (96 pages) : illustrations, digital ; 17 cm.
- **Content Type**: text
- **Media Type**: computer
- **Carrier Type**: online resource

**Subject**
- Academic writing
- Thought and thinking
- **Academic writing**
- LANGUAGE ARTS & DISCIPLINES / Composition & Creative Writing
- LANGUAGE ARTS & DISCIPLINES / Rhetoric
- REFERENCE / Writing Skills
- Thought and thinking

**Genre/Form**
- Electronic books.

**Links to other extend sources via Subject terms hyperlinks.**
Library Catalog

Paper Collection :
500,000+ books
9,000+ journals

E-Collection :
700,000+ books
80,000+ journals
300+ databases

(in European languages)
A bibliography is a list of works on a subject or by an author that were used or consulted to write a research paper, book or article. It can also be referred to as a list of works cited. It is usually found at the end of a book, article or research paper.

- **Book & Journal Article**
  - Author name
  - Title of publication
  - Article title (if using a journal)
  - Date of publication
  - Place of publication
  - Publisher
  - Volume number of a journal, magazine or encyclopedia
  - Page number(s)

- **Theses & Conference proceedings**
  - Author name
  - Title
  - Date of Publication
  - Degree
  - Name of University/Conference


B. Krismer, A. Hoppe,. “Process for recovering niobium and/or tantalum compounds from such residues further containing complexes of uranium, thorium, titanium and/or rare earth metals. . Patent US4446116, 1984.


Spotlight Resources. (n.d.). Retrieved from https://owl.purdue.edu/owl/about_the_owl/owl_information/spotlight_resources.html

Purdue University Writing Lab [Facebook page]. (n.d.). Retrieved January 22, 2019, from https://www.facebook.com/PurdueUniversityWritingLab/

<table>
<thead>
<tr>
<th>Type</th>
<th>Citation</th>
</tr>
</thead>
</table>
Gather Materials

Library online catalog

• Paper Collection
  • Books
  • Journals, Magazine
  • Thesis and Dissertation
  • E-book (Single)

Discovery Search

• Simple search
  • Paper+(Part of) E-resources
    • Library catalog
    • (Part of) E-resources
    • (Part of) Web open resources
  *Easy access to articles, ebooks, databases, and ejournals from one search box.

E-resources Gateway

• E-resources (Subscribed, Free and Trial)
  • Database
  • Journal
  • E-book (platform)
  • Bibliography software

Media online

• Media resources
  • Video on demand
  • Educational Videos
  • Online Audio Library
  • Media Resources & Links

Media Center
@B1F
Books/E-Books & Interlibrary loan
Library Search

Find Books
- By topic
- By title

Search Library Catalog
- Keyword
- Title
- Topic

Taiwan
- MetaCat+
- NBINet Union Catalog

Overseas
- WorldCat

Interlibrary loan

Library does not hold the material

Library holds materials
Borrowing (print/electronic)
Open new tab in browser “Library catalog”
Search Library Catalog

Use title search instead of keyword search

OR

Try subject search to expand more materials
Search Library Catalog

Night and day
Virginia Woolf.

If holding is not available, try e-book for instead. Or, compare the difference between 2 versions.

Night and day
Virginia Woolf.

<table>
<thead>
<tr>
<th>Location</th>
<th>Item Barcode</th>
<th>Call No.</th>
<th>Item Status (YY-MM-DD)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main Lib B2F Foreign Language</td>
<td>1379675</td>
<td>823.912 W883bn</td>
<td>Available</td>
</tr>
</tbody>
</table>

Website (Off-campus Access Setup)
3rd Floor
Inter-Library Loan Service

1st Floor
Circulation Desk, Reference Desk, Reference Resources, Special Reference Collections

2nd Basement
(Non-Chinese language collections)
Foreign Language Books, Bound Periodicals, Bound Newspapers, Oversize Books, Oversize Bound Periodicals

Near the elevator
2nd Basement, Main Library
Locate books

- Unique number to each book.
- Contact information desk with this #, if you cannot find it.

Available
DUE yy-mm-dd
DUE yy-mm-dd + N HOLD
On Holdshelf
Lib Use Only

Need help to operate the Compact Shelving?
Contact with service counter.
Find E-Books

1. Searching Library Catalog
   Choosing material type: E-Books

   - Use when: Search on a specific topic or Find a specific book.

2. E-Resources Gateway
   Choosing material type: E-Books

   - Use when: Browse e-book collection on different platform from different suppliers.
   - Click Info for more description of platform coverage.
1 Searching for E-Books

This E-book was published or collected on JSTOR Open Access.

Click to open new tab, read online or download.
E-Resources Gateway
Choose material type “E-Books”

Most platforms support multiple search, i.e. Title/Content/Subject…

Discover the fascinating topic of Swarm Intelligence
A new, comprehensive 3-Vol review on the principles of current and new swarm intelligence algorithms, inspiring new insights and applications.

Or browse collections via platform categories
Browse by title
Browse by author
Browse by topic
E-Book

Unsure about title? No ideas about library holdings?
Search via Title/Subject Keywords

1. Start Over: Modify Search
   - Title:
   - Subject: electronic filter
   - View Entire Collection
   - System Sorted
   - Search

2. Record:
   - Title: Electronic filter analysis and synthesis / Michael G. Ellis, Sr.
   - Author: Ellis, Michael G. (Michael Glynn), 1960-
   - Location: Main Lib B2F Foreign Language Books
     - Item Barcode: 2047295
     - Call No.: 621.3815324 Eli9
     - Item Status (YY-MM-DD): DUE 19-09-20
   - Description: xii, 268 p. : ill. : 24 cm.
   - Bibliography: Includes bibliographical references (p. 259) and index.
   - Subject: Electric filters -- Mathematical models.
   - Electric filters -- Design and construction.

3. Search Results:
   - Subject: Electric filters
   - Design and construction
   - Year: 1987
   - Entries: 21

Click subject to expand more results.
If NCKU Library does not hold the material you need.
The illustrated world encyclopedia of insects: a natural history and identification guide to beetles
Walters, Martin
256 p.: col. ill., col. maps; 31 cm

Circulation availability: 1 copy available at Chung- hsing Univ. Libr.
WorldCat is a union catalog that itemizes the collections of more than 17,000 libraries in 123 countries and territories.
City Public Library and branches

Non-Taiwanese citizens can apply for a library card (with valid passport or Resident Certificate)

Tainan Public Libraries
https://lib.tnml.tn.edu.tw/webpac/search.cfm
1. Search library catalog, does library hold this item?

2. Search library catalog with author name Yoshua Bengio, how many holdings in NCKU library?

3. As above, search METACAT+ with author name Yoshua Bengio, how many results?
No matches results?

Authority control: Family Name, First Name

Your entry Yoshua Bengio would be here ....... Change search to Bengio, Yoshua
If NCKU Library does not hold the material you need

Interlibrary Loan

Interlibrary loan

Free
(Visit libraries in person)

Pay
(Items will be delivered to NCKU library)

Interlibrary Borrowing

book loan

Photocopies

Apply for Inter-Library Card at Circulation desk

Nationwide Document Delivery Service (NDDS / Taiwan)

Nationwide Document Delivery Service (NDDS / Taiwan)

RapidILL Express Document Delivery Service (Overseas)

Contact with 3F, Periodical Department for further help (ext. 65741)

English & European languages: RapidILL (No requirement for new account)
Chinese & Other languages: NDDS (Require for apply new account)

1. The library uses your NCKU e-mail address for delivery of all notices.
2. Many libraries charge from NTD$150 to NTD$250 for lending a single title.
3. There is typically 3-7 working days turnaround time on each request.
4. Place orders for research materials well in advance of the time they are needed.
### Book Loan Request Form

- **Request Date**: 08/27/2019
- **Name**
- **Borrower**: National Cheng Kung University Library
- **Book Title**: The Nature of space and time
- **Author**: Stephen Hawking
- **Year**: 1996
- **Edition**
- **Lender**: 136-National Taiwan University Library
- **Call Number**: 30.11 H313
- **Delivery Method**: Registered

**NDDS Interlibrary cooperation library**
### RapidILL Express Document Delivery Service

#### New Request **|** Status Check **|** Logout

<table>
<thead>
<tr>
<th>Request Date:</th>
<th>2019-08-26</th>
</tr>
</thead>
<tbody>
<tr>
<td>User ID:</td>
<td></td>
</tr>
<tr>
<td>Department:</td>
<td>Library</td>
</tr>
<tr>
<td>Needed by:</td>
<td></td>
</tr>
<tr>
<td>Email:</td>
<td>@gmail.com</td>
</tr>
<tr>
<td>Notes:</td>
<td>For pick up notice</td>
</tr>
</tbody>
</table>

**Required field**
- At least check one as appropriate

- **Request Type:** Journal Article
- **Book Chapters**

**Journal Title:** Journal of the Abraham Lincoln Association
- **Article Title:** Looking for Lincoln's Philadelphia: A Personal Journey from Washington Square to Independence Hall
- **Article Author:** Bradley R. Hoch
- **Volume:** 25
- **Issue:** 2
- **Year:** 2004
- **Pages:** 69-70 (NT$3/page) [color $6/page: No ▼](if color printing is provided by the suppliers)

- **ISSN:**
- **Check ISSN:** LC online catalog; NLM catalog

**If item is unavailable from RapidILL, agree to request from NDDS, and charged according to the supplying library.** No ▼

**If item is unavailable from RapidILL and NDDS, agree to request from overseas libraries. The charge is NT$450.** No ▼

---

1. *Login with NCKU student ID/PW, fill out an online application with more details can make your application process faster.*
2. *Allow library transfer your request to NDDS (based on personal budget)*
## Interlibrary loan

<table>
<thead>
<tr>
<th>Material type</th>
<th>RapidILL</th>
<th>NDDS</th>
</tr>
</thead>
</table>
| Photocopies   | Journals, books and conference proceedings, mainly in **English** or European languages. | 1. **Photocopies** : Journals, books, research papers, theses, conference proceedings, in Chinese, English, Japanese or other languages.  
2. **Borrow** : Books in all language. |

| Application | Apply online, pick up materials at NCKU library after further notice. | Apply online, pick up materials at NCKU library after further notice. |

| Cost | NTD$3/per page | Determined by the lending institution. |

<table>
<thead>
<tr>
<th>Login ID/PW</th>
<th>NCKU ID/PW</th>
<th>Register a new account</th>
</tr>
</thead>
</table>

| 備註 | Faster, Cheaper (than NDDS)  
May received within 24 hours |  |
Picking Up Requested Materials

1. Where to pick up?
   Materials ordered through Interlibrary Loan can be picked up at the Services Desk, 3F, Main Library

2. You may be required to present your NCKU ID

3. Service time
   Any time the library is open, but better on weekdays, 8:00-17:00.

4. Borrowers are notified through their e-mail account as soon as the material is received.
E-Resources

Databases
A database is a collection of items, presented in the form of individual items or records, which you can search and browse using a computer or device.
Off-campus user

1. E-Resources Gateway (enter ID/PW)

Click E-database title, open a new tab for entering NCKU ID/PW for access.

2. Virtual Private Network
NCKU Computer & Network center
Academic Search Complete is a comprehensive scholarly, multi-disciplinary full-text database, with more than 5,500 full-text periodicals, including more than 4,600 peer-reviewed journals. In addition to full text, this database offers indexing and abstracts for more than 9,500 journals and a total of nearly 10,000 publications including monographs, reports, conference proceedings, etc. ...
Welcome to the e-resources of National Cheng Kung University Library. To access the system, please obey NCKU Library E-resources Use Regulations and click the links listed below.

1. **E-Resources Gateway**
   - http://er.lib.ncku.edu.tw

   E-resources Gateway includes all databases, e-journals, medical e-resources and library instruction courses in NCKU Library.

2. **Discovery Search**

   Search across the books, articles, electronic resources by one-stop search.
   And results can be sorted, facet-filtered, guided to full-text, and exported as personal service.
Search e-resources

Search for Databases by Name

Using when:
Want to connect to specific database.
Limit:
May unfamiliar with field databases.

Discovery search (Simple search)

Using when:
Simple and basic with keywords or subject terms for general topics.
Limit:
As authorized limits, can not access all subscribed databases.
Preventing Password Leaks & Creating a Strong Password

A strong password must contain characters from at least 3 of the following 4 classes: upper case letters, lower case letters, Arabic numerals, and special characters (!@#$).
### Search by Database Name

#### Browse by different facet

#### Resources search

<table>
<thead>
<tr>
<th>ID</th>
<th>Title</th>
<th>Type</th>
<th>Publisher / ISSN</th>
<th>Coverage</th>
<th>Note</th>
<th>Web2.0</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Royal Society of Chemistry (RSC) eBooks</td>
<td>eBooks</td>
<td>Royal Society of Chemistry</td>
<td>E-books List</td>
<td>view: 507</td>
<td>bookmark: 2, recommend: 0</td>
</tr>
<tr>
<td>2</td>
<td>RSC Journals</td>
<td>Journals</td>
<td>Royal Society of Chemistry</td>
<td>Advice</td>
<td>view: 878</td>
<td>bookmark: 8, recommend: 2</td>
</tr>
</tbody>
</table>

* Authorization of download full-text is only for our subscribed items, not all items in the database.
Recommended databases

General/Multidisciplinary

Web of Science – SCI, SSCI & AHCI
Platform connects regional, specialty, data and patent indexes to the Web of Science Core Collection. Allows users to track ideas across disciplines and time from over 1.7 billion cited references from over 159 million records.

- Science Citation Index Expanded (SCIE)
- Social Sciences Citation Index (SSCI)
- Arts & Humanities Citation Index (AHCI)

Scopus
One of the largest abstract and citation database of peer-reviewed literature and quality web sources with smart tools to track, analyze and visualize research. Updated daily, it includes the abstracts and references of 15,000 peer-reviewed journals from more than 4,000 international publishers. In addition, Scopus offers seamless linking to full-text articles and other library resources and also integrates web and patent searches directly from its clean and simple interface.

Academic Search Complete
Multi-disciplinary full-text database, with more than 5,500 full-text periodicals, including more than 4,600 peer-reviewed journals. In addition to full text, this database offers indexing and abstracts for more than 9,500 journals and a total of nearly 10,000 publications including monographs, reports, conference proceedings, etc.
# Recommended databases

## Theses & Dissertation

- **Taiwan**
  - National Digital Library of Theses and Dissertations in Taiwan (NDLTD)

- **North America**
  - ProQuest Dissertations and Theses (PQDT)
  - Digital Dissertation Consortium (DDC)

## Art collection

- **Art & Design**
  - Art & Architecture Complete Design and Applied Arts Index

## Image & Digitalarchives

- ARTstor Digital Library
- Britannica Image Quest
- Global Plants
- NYPL Digital Collections
- Open FREER | SACKLER

## Laws & Regulations

- Beck online (in german)
- Lexis Advance

---

## Find more: By subject

<table>
<thead>
<tr>
<th>Subject (EN)</th>
<th>Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>A ART &amp; HUMANITIES</td>
<td>302</td>
</tr>
<tr>
<td>B LIFE SCIENCE</td>
<td>159</td>
</tr>
<tr>
<td>C SOCIAL SCIENCE</td>
<td>199</td>
</tr>
<tr>
<td>D BUSINESS &amp; MANAGEMENT</td>
<td>179</td>
</tr>
<tr>
<td>E SCIENCE &amp; ENGINEERING</td>
<td>204</td>
</tr>
<tr>
<td>F MEDICINE</td>
<td>114</td>
</tr>
<tr>
<td>G GENERALITIES</td>
<td>139</td>
</tr>
<tr>
<td>Z OTHERS</td>
<td>16</td>
</tr>
</tbody>
</table>
Recommended databases

Journals

Linguistics and Language
MLA International Bibliography, Linguistics and Language Behavior Abstracts (LLBA)

Literature
Literature Online
Literature Resource Center

Social Science
PsycARTICLES [EBSCOhost]
Eric [EBSCOhost]

Science
ACS Journals (Chemical)
AIP Journals (Physics)
Annual Reviews Online (Mathetic)
MathSciNet (Mathmetic)
Earth, Atmospheric & Aquatic Science Database

Business and Management
Business Source Complete [EBSCOhost]
Emerald Management 120

Biology and Medicine
Biological Science Database [ProQuest]
AACR Journals
Nature Journals Online
Medline
PubMed

Engineering and Computer Science
Compendex [Ei Engineering Village 2]
ACM Digital Library
IEL
AIAA Journals
ASME Digital Collection (Journals only)

Find more: By subject
1. Find and links to NCKU E-Resources Gateway
2. Find 2 research area databases
3. List 3-5 research keywords
Searching Skills

Databases search:
Web of Science
Scopus
Academic Search Complete
1. Task Definition
   Define the information problem
   Identify information needed

2. Information Seeking Strategies
   Determine all possible sources
   Select the best sources

3. Location and Access
   Locate sources (intellectually and physically)
   Find information within sources

4. Use of Information
   Engage (e.g., read, view...)
   Extract relevant information

5. Synthesis
   Organize from multiple sources
   Present the information

6. Evaluation
   Judge the product (effectiveness)
   Judge the process (efficiency)

Satisfaction

Refine your search OR Plan a new search

The Big6
Keyword search with Boolean operator

Boolean searching allows you to combine keywords using **AND**, **OR**, and **NOT** (e.g., society and literature or fiction).

<table>
<thead>
<tr>
<th>AND</th>
<th>OR</th>
<th>NOT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Each result contains all search terms.</td>
<td>Each result contains at least one search term.</td>
<td>Results do not contain the specified terms.</td>
</tr>
<tr>
<td>The search <strong>heart and lung</strong> finds items that contain both heart and lung.</td>
<td>The search <strong>heart or lung</strong> finds items that contain either heart or items that contain lung.</td>
<td>The search <strong>heart not lung</strong> finds items that contain heart but do not contain lung.</td>
</tr>
</tbody>
</table>

Basic search skills
Use Truncation and Phrasing

**Truncation**

Use truncation to find variant endings

<table>
<thead>
<tr>
<th>If you enter a search for...</th>
<th>...find...</th>
</tr>
</thead>
<tbody>
<tr>
<td>electro*</td>
<td>electron, electrons, electronics, electromechanical...</td>
</tr>
<tr>
<td>*optic</td>
<td>optic, fiber-optic, electrooptic...</td>
</tr>
<tr>
<td>me*n</td>
<td>men, mean, median...</td>
</tr>
</tbody>
</table>

**Phrasing**

Search for phrases by using brackets or quotation marks,

“Internet of things” = Search “Internet of things”

Internet of things = Search “Internet” & “things”

**Stop Words**

<table>
<thead>
<tr>
<th>a</th>
<th>as</th>
<th>have</th>
<th>of</th>
</tr>
</thead>
<tbody>
<tr>
<td>about</td>
<td>at</td>
<td>how</td>
<td>on</td>
</tr>
<tr>
<td>above</td>
<td>can</td>
<td>I</td>
<td>or</td>
</tr>
<tr>
<td>an</td>
<td>do</td>
<td>in</td>
<td>over</td>
</tr>
</tbody>
</table>

and more...
Select Keywords

**Keywords**

1. Identifying the main concepts of your topic
2. Brainstorming synonyms and antonyms that could also be used to describe your topic
3. Spell out abbreviations

**Abbreviations**

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Complete Phrase</th>
</tr>
</thead>
<tbody>
<tr>
<td>ESL</td>
<td>English as a Second Language</td>
</tr>
<tr>
<td>EFL</td>
<td>English as a Foreign Language</td>
</tr>
<tr>
<td>SWOT</td>
<td>Strengths, Weaknesses, Opportunities, and Threats</td>
</tr>
<tr>
<td>OCD</td>
<td>Obsessive Compulsive Disorder</td>
</tr>
<tr>
<td>ADHD</td>
<td>Attention-Deficit/Hyperactivity Disorder</td>
</tr>
</tbody>
</table>

**Synonyms & antonyms**

Synonyms: words that have the same or similar meaning.
Antonyms: words that have the opposite meaning.

https://www.thesaurus.com/
https://www.merriam-webster.com/

e.g. CRS could be Cytoreductive surgery, Common reflection surface OR Common Reporting Standard.
Locate articles in a database using keywords

Web of Science

Field Tags:
- **TS** = Topic
- **Ti** = Title
- **AU** = Author [Index]
- **AI** = Author Identifiers
- **GP** = Group Author [Index]
- **ED** = Editor
- **SO** = Publication Name [Index]
- **DO** = DOI
- **PY** = Year Published
- **AD** = Address
- **OG** = Organization-Enhanced [Index]
- **DO** = Organization
- **SG** = Suborganization
- **IS** = ISSN/ISBN
- **UT** = Accession Number
- **PMID** = PubMed ID
- **ALL** = All Fields

Metadata Only
- Document Title
- Authors
- Publication Title
- Abstract
- Index Terms
- Accession Number
- Article Number
- Article Page Number
- Author Affiliations
- Author Keywords
- Author ORCID
- DOI
- Funding Agency
- IEEE Terms
- INSPEC Controlled Terms
- INSPEC Non-Controlled Terms
- ISBN
- ISSN
- Issue
- Mesh Terms
- Publication Number
- Parent Publication Number
- Standards Dictionary Terms
- Standards ICS Terms
- Standard Number
Search terms:
- electronic filter
- oil spill * mediterranean

Timespan:
- All years (1900 - 2019)
Web of Science

Results: 6,169
(from Web of Science Core Collection)

You searched for: TOPIC: (electronics filter) ...More

Refine Results

Search within results for...

Filter results by:
- Highly Cited in Field (54)
- Hot Papers in Field (1)
- Open Access (1,244)

Refine

Sort by: Date ▼  Times Cited  Usage Count  Relevance  More ▼

1. Fluxonic Processing of Photonic Synapse Events
   By: Shainline, Jeffrey M.
   IEEE JOURNAL OF SELECTED TOPICS IN QUANTUM ELECTRONICS Volume: 26 Issue: 1 Article Number: 7700315 Published: JAN-FEB 2020
   [Find in NCKU]  Full Text from Publisher  View Abstract

2. A Phase-Locked Loop Algorithm for Single-Phase Systems With Inherent Disturbance Rejection
   By: Lima, Francisco Kleber de A.; Araujo, Renato G.; Tofoli, Fernando L.; et al.
   IEEE TRANSACTIONS ON INDUSTRIAL ELECTRONICS Volume: 66 Issue: 12 Pages: 9260-9267 Published: DEC 2019
   [Find in NCKU]  Full Text from Publisher  View Abstract

3. A personalized electricity tariff recommender system based on advanced metering infrastructure and collaborative filtering
   By: Li, Shun; Luo, Fengii; Yang, Jiajia; et al.
   INTERNATIONAL JOURNAL OF ELECTRICAL POWER & ENERGY SYSTEMS Volume: 114 Pages: 40-48 Published: OCT 2019
   [Find in NCKU]  Full Text from Publisher  View Abstract
Hybrid recommender systems: Survey and experiments

By: Burke, R (Burke, R)

USER MODELING AND USER-ADAPTED INTERACTION
Volume: 12 Issue: 4 Pages: 331-370
DOI: 10.1023/A:1021240730564
Published: NOV 2002
Document Type: Article
View Journal Impact

Abstract
Recommender systems represent user preferences for the purpose of suggesting items to purchase or examine. They have been used in electronic commerce and information access, providing suggestions that effectively prune large information spaces so users can more easily identify those items that best meet their needs and preferences. A variety of techniques have been proposed for performing recommendation, based on collaborative and knowledge-based and other techniques. To improve performance, these methods have sometimes been combined into a single recommender. This paper surveys the landscape of actual and possible hybrid recommenders, and introduces a novel hybrid system that combines knowledge-based recommendation and collaborative filtering to recommend restaurants. Further, we show that the knowledge-based part of the system enhances the effectiveness of collaborative filtering.

Keywords

Citation Network
In Web of Science Core Collection
1,362
Times Cited

Most recently cited by:
van Capelleveen, Guido; Amrit, Chintan; Yazan, Devrim Murat; et al.
The recommender canvas: A model for developing and documenting recommender system design.
EXPERT SYSTEMS WITH APPLICATIONS (2019)

Rivas, Alberto; Channosso, Pablo; Gonzalez-Brones, Alfonso; et al.
Hybrid job offer recommender system in a social network.
EXPERT SYSTEMS (2019)

View All

View Related Records
Citation Connections

Source from: https://clarivate.libguides.com/woscc/citationnetwork
↑ environmental space (and) engineering
2,512 document results

↓ “environmental engineering”
1,192 document results
Appreciating the role of carbon nanotube composites in preventing biofouling and promoting biofilms on material surfaces in environmental engineering: A review

Upadhyayula, V.K.K. a, Gadhamshetty, V. b

aOak Ridge Institute of Science and Education (ORISE), MC-100-44, PO Box 117, Oak Ridge, TN, 37831, United States
bRensselaer Polytechnic Institute, Department of Civil and Environmental Engineering, 4040 JEC Building, 110 8th Street, Troy, NY, 12180, United States

Abstract

Cited by 99 documents

Related documents
Cited by 99 documents

Nanoparticles in the aquatic environment: Usage, properties, transformation and toxicity — A review

Effects of multi-walled carbon nanotubes on metabolic function of the microbial community in riverine sediment contaminated with phenanthrene

Carbon nanotube membranes for water purification: Developments, challenges, and prospects for the future
Ihsanullah (2019) Separation and Purification Technology

View all 99 citing documents

<table>
<thead>
<tr>
<th>Author</th>
<th>Documents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rodrigues, D.F.</td>
<td>5</td>
</tr>
<tr>
<td>Ahmed, F.</td>
<td>4</td>
</tr>
<tr>
<td>Santos, C.M.</td>
<td>4</td>
</tr>
<tr>
<td>Adebisi, A.</td>
<td>2</td>
</tr>
<tr>
<td>Advincula, R.</td>
<td>2</td>
</tr>
<tr>
<td>Advincula, R.C.</td>
<td>2</td>
</tr>
<tr>
<td>Bai, Y.</td>
<td>2</td>
</tr>
<tr>
<td>Bayer, I.S.</td>
<td>2</td>
</tr>
<tr>
<td>Bouwer, E.J.</td>
<td>2</td>
</tr>
<tr>
<td>Cao, L.</td>
<td>2</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Source</th>
<th>Documents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Carbon</td>
<td>4</td>
</tr>
<tr>
<td>Applied Biochemistry And Microbiology</td>
<td>4</td>
</tr>
<tr>
<td>Chemical Engineering Journal</td>
<td>2</td>
</tr>
<tr>
<td>Desalination</td>
<td>2</td>
</tr>
<tr>
<td>Desalination And Water Treatment</td>
<td>2</td>
</tr>
<tr>
<td>Environmental Science And Technology</td>
<td>2</td>
</tr>
<tr>
<td>International Orthopaedics</td>
<td>2</td>
</tr>
<tr>
<td>Journal Of Nanoscience And Nanotechnology</td>
<td>2</td>
</tr>
<tr>
<td>Materials Research Express</td>
<td>2</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Affiliation</th>
<th>Documents</th>
</tr>
</thead>
<tbody>
<tr>
<td>University of Houston</td>
<td>5</td>
</tr>
<tr>
<td>Ministry of Education China</td>
<td>3</td>
</tr>
<tr>
<td>Consiglio Nazionale delle Ricerche</td>
<td>3</td>
</tr>
<tr>
<td>United States Environmental Protection Agency</td>
<td>3</td>
</tr>
<tr>
<td>Universidad Autónoma de Aguascalientes</td>
<td>2</td>
</tr>
<tr>
<td>Arizona State University</td>
<td>2</td>
</tr>
<tr>
<td>Johns Hopkins University</td>
<td>2</td>
</tr>
<tr>
<td>Newcastle University, United Kingdom</td>
<td>2</td>
</tr>
<tr>
<td>Universidad Autónoma de Ciudad Real</td>
<td>2</td>
</tr>
</tbody>
</table>
### Cited by 99 documents

**Nanoparticles in the aquatic environment: Usage, properties, transformation and toxicity — A review**

**Effects of multi-walled carbon nanotubes on metabolic function of the microbial community in riverine sediment contaminated with phenanthrene**

**Carbon nanotube membranes for water purification: Developments, challenges, and prospects for the future**
Ihsanullah (2019) Separation and Purification Technology

---

### View all 99 citing documents

<table>
<thead>
<tr>
<th>Author</th>
<th>Documents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rodrigues, D.F.</td>
<td>5</td>
</tr>
<tr>
<td>Ahmed, F.</td>
<td>4</td>
</tr>
<tr>
<td>Santos, C.M.</td>
<td>4</td>
</tr>
<tr>
<td>Adebisi, A.</td>
<td>2</td>
</tr>
<tr>
<td>Advincula, R.</td>
<td>2</td>
</tr>
<tr>
<td>Advincula, R.C.</td>
<td>2</td>
</tr>
<tr>
<td>Bai, Y.</td>
<td>2</td>
</tr>
<tr>
<td>Bayer, I.S.</td>
<td>2</td>
</tr>
<tr>
<td>Bouwer, E.J.</td>
<td>2</td>
</tr>
<tr>
<td>Cao, L.</td>
<td>2</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Source</th>
<th>Documents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Carbon</td>
<td>4</td>
</tr>
<tr>
<td>Applied Biochemistry And Microbiology</td>
<td>2</td>
</tr>
<tr>
<td>Chemical Engineering Journal</td>
<td>2</td>
</tr>
<tr>
<td>Desalination</td>
<td>2</td>
</tr>
<tr>
<td>Desalination And Water Treatment</td>
<td>2</td>
</tr>
<tr>
<td>Environmental Science And Technology</td>
<td>2</td>
</tr>
<tr>
<td>International Orthopaedics</td>
<td>2</td>
</tr>
<tr>
<td>Journal Of Nanoscience And Nanotechnology</td>
<td>2</td>
</tr>
<tr>
<td>Materials Research Express</td>
<td>2</td>
</tr>
</tbody>
</table>

### Affiliation

- University of Houston: 5
- Ministry of Education China: 3
- Consiglio Nazionale delle Ricerche: 3
- United States Environmental Protection Agency: 3
- Universidad Autónoma de Aguascalientes: 2
- Arizona State University: 2
- Johns Hopkins University: 2
- Newcastle University, United Kingdom: 2
- Universidad Autónoma de Ciudad: 2
1. Eye centring in selfies posted on Instagram.


Subjects: SELFIES; EYE; MONTE Carlo method; THEMES in painting; PHYSICAL sciences; Research and Development in the Physical, Engineering, and Life Sciences (except Biotechnology)


Subjects: ACADEMIC libraries; WEB development; SELF-help devices for people with disabilities; SOCIAL media; HUMAN services programs; INDIANA, MONTANA; Libraries and Archives
Eye centring in selfies posted on Instagram.

Authors: Bruno, Nicola\(^1\) nicola.bruno@uni.pr.it
Bertamini, Marco\(^2\) M.Bertamini@liverpool.ac.uk
Tylor, Christopher W.\(^3\)


Document Type: Article

Subject Terms:
*SELFIES
*EYE
*MONTÉ Carlo method
*THEMES in painting
*PHYSICAL sciences

Author-Supplied Keywords:
Anatomy
Biology and life sciences
Cell phones
Cheeks
Communication equipment
Communications
Computer and information sciences
Engineering and technology
Equipment
Eyes
Too many/few results

**Too Many**

General Keywords (~10,000)

Refine

Sort by

30~180 results

- Add Another Search Term
- Use Limits (Refine options)
- See Search Techniques
- Sorting Options
  - Relevance: Usually the default
  - Citation count: Put the most cited on the top
  - Date: Put the newest or oldest stuff on top
  - Field: Relevant research field

**Too Few**

3~5 results

References

Times Cited

Related Records

Keyword Plus

30~180 results

- Remove Limits and/or Search Terms
  - If the database uses Boolean operators, try combining terms with or instead of and.
  - Use broad terms instead of narrow terms
- Follow the Bibliographic Links
1. Find 2 databases which related to your research field / Subject
   *Tips: Via NCKU E-resources Gateway
   *Tips: By Subject or Department

2. List 3-5 Keywords/Subject terms

3. Try Search in following Multidisciplinary Databases
   1) Web of Science
   2) Scopus
   3) Academic Search Complete
   *Tips: Search by Name via NCKU E-resources Gateway

4. Limit or expand your results to 30~200 results.
Find Journal Articles

- By Topics
  - Journal Database
    - Full-text database
    - Index & Abstract database
    - Index database
  - Abstract and citation database
    (Explore citation network, analyze the development of a research field, find out Top Authors)
  - Web of Science
  - Scopus
  - Impact Factor
    - JCR/SJR

Find a Specific Article
(Known Arthur, Article Title, Journal Name, Volume, Issue, Publication Year, pages)

- (1) NCKU E-Resources Gateway
- (2) NCKU Library Catalog

- Locate holdings
- Download Full-text
  - RapidILL Express Document Delivery Service
  - Nationwide Document Delivery Service (NDDS)

Apply for Photocopies of Journal Articles

Find Top Journals in a Subject or Topic
Click journal title, open a new tab of E-Journal Gateway, check for holdings coverage.

Subscribed from 1997 to 2017
Based on license agreement, only NCKU registered users can access off campus.
EXCESSIVE DOWNLOADING OF ELECTRONIC RESOURCES IS PROHIBITED! Publishers have the right to block access if systematic downloading is detected.
1. Find 2 research area journals and link to journal platform

Theses and Dissertations

Find Theses and Dissertations

Taiwan

- NCKU
  - (1) Electronic Thesis & Dissertations Services
  - (2) NCKU Institutional Repository

- Other Universities
  - (1) National Digital Library of Theses and Dissertations in Taiwan
  - (2) Airiti Electronic Theses & Dissertations Services (CETD)

Other Universities

North America

- Library subscribed
  - Digital Dissertation Consortium

- Others
  - OA Theses
  - U.K

Overseas

- North America
  - ProQuest Dissertations and Theses (PQDT)
  - NDLTD
  - OATD
  - EThOS
  - Europe
  - DART-Europe

- Others
  - Purchase online
  - RapidILL
  - NDDS
  - Photocopies
  - Get full-text

Library Catalog & E-Theses service

Institutional Repository
Default display language is Chinese..., try NDLTD (National Library, Taiwan) instead.
1. An Analysis of the Impact of Automation on Technological Unemployment

Author (Eng.): JASON YANG
advisor (eng): I-heng Chen

Delay release until yyyy-mm-dd
Reformists or Radicals? A Study of the Discourse and Strategy of the Basic Income Movement in Taiwan

Related Articles:
Cited the same references.

1. Contemporary Women's Movement and Feminist Practices in Taiwan
2. A Study of Evolution of the Mechanization Department Development - "Take One MNC"s Production Center for Example
3. The study on Tai-Power dispatchers, chandane psychological cognition: for power system dispatch automation
4. Social Media and the Sunflower Student Movement
5. Social Movements, Music and Documentary in Democratic Taiwan
6. "Unconditional Basic Income" - A Preliminary Exploration on the case of Taiwan
7. Democratic Transition and Consolidation: Mongolia and Taiwan
Refine your search by choosing English articles.
### Top lists

<table>
<thead>
<tr>
<th>Subject</th>
<th>Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agriculture</td>
<td>5112</td>
</tr>
<tr>
<td>Biological Sciences</td>
<td>11870</td>
</tr>
<tr>
<td>Geosciences</td>
<td>4990</td>
</tr>
<tr>
<td>Environmental Sciences</td>
<td>5746</td>
</tr>
<tr>
<td>Language</td>
<td>10067</td>
</tr>
<tr>
<td>Philosophy and Religion</td>
<td>9497</td>
</tr>
<tr>
<td>Architecture</td>
<td>3582</td>
</tr>
<tr>
<td>Business</td>
<td>28138</td>
</tr>
<tr>
<td>Ecosystem Sciences</td>
<td>2305</td>
</tr>
<tr>
<td>Health and Medical Sciences</td>
<td>21836</td>
</tr>
<tr>
<td>Literature</td>
<td>10171</td>
</tr>
<tr>
<td>Social Science</td>
<td>5806</td>
</tr>
<tr>
<td>Area, Ethnic, and Gender Studies</td>
<td>20442</td>
</tr>
<tr>
<td>Communications and Information Sciences</td>
<td>17470</td>
</tr>
<tr>
<td>Education</td>
<td>53362</td>
</tr>
<tr>
<td>History</td>
<td>10817</td>
</tr>
<tr>
<td>Law and Legal Studies</td>
<td>6872</td>
</tr>
<tr>
<td>Behavioral Science</td>
<td>24283</td>
</tr>
<tr>
<td>Fine and Performing Arts</td>
<td>15497</td>
</tr>
<tr>
<td>Engineering</td>
<td>46668</td>
</tr>
<tr>
<td>Interdisciplinary</td>
<td>10565</td>
</tr>
<tr>
<td>Mathematical and Physical Sciences</td>
<td>23843</td>
</tr>
</tbody>
</table>

---

85
Find Theses in University Institutional Repository

Ajallooeian, Mohammad Mahdi. 2013 University of Alberta (Canada)

University Name + Institutional Repository

university of alberta institutional repository
1. Find at least 3 theses by your department/institute/research fields, graduated/published from 2010-2019, via:
   ① National Digital Library of Theses and Dissertations in Taiwan
   ② Digital Dissertation Consortium
   ③ ProQuest Dissertations and Theses (PQDT)

2. Try searching following Internet resources:
   ① Networked Digital Library of Theses and Dissertations (NDLTD) Union Catalog
   ② Open Access Theses and Dissertations (OATD)
   ③ British Library e-theses online service (EThOS)
   ④ DART-Europe E-theses Portal
Academic search engines

Google Scholar & Microsoft Academic Search
**Advantages:**

1. Google Scholar is familiar and relatively simple to use, much like Google.
2. Google Scholar allows users to search for a wide variety of materials including articles, books, "grey literature" like conference proceedings on a vast number of topics.
3. Google Scholar allows for you to see articles related to the one that might interest you, how many times an article has been cited and by whom, and provides citations for articles in a number of styles.
4. Google Scholar can display links to articles and books held through NCKU Libraries. For more information, see Using Google Scholar from Home tab.
5. Google Scholar allows you to save both citations and articles to read later.

**Disadvantages:**

1. Google Scholar's coverage is wide-ranging but not comprehensive. It can be a research source, but should not be the only source you use.
2. Google Scholar does not provide the criteria for what makes its results "scholarly". Results are often vary in quality and it is up to the researcher to determine which of the results are suitable for their purposes.
3. Google Scholar does not allow users to limit results to either peer reviewed or full text materials or by discipline.
4. Google Scholar does not provide notice of when its materials are updated.
5. Google Scholar's citation tracker can be difficult to use and inaccurate.
Setting up Library Links in Google Scholar

1. Login your google account

2. Search “NCKU” & “National Cheng Kung University”
   Choose 4 results in total
Access Google Scholar both on and off campus

Connect to the library's resources
Access Google Scholar both on and off campus

Before

About 3,820,000 results (0:04 sec)

*mobile networks and applications*

Mobilennets: Efficient convolutional neural networks for mobile vision applications
We present a class of efficient models called MobileNets for mobile and embedded vision applications. MobileNets are based on a streamlined architecture that uses depth-wise separable convolutions to build light weight deep neural networks. We introduce two simple...

*book* Mobile, wireless, and sensor networks: technology, applications, and future directions
R. Sherry, A. Ananda, M. Chan, W. Qii - 2006 - books.google.com
This publication represents the best thinking and solutions to a myriad of contemporary issues in wireless networks. Coverage includes wireless LANs, multihop wireless networks, and sensor networks. Readers are provided with insightful guidance in tackling such issues...

Locating a mobile station using a plurality of wireless networks and applications therefor
A location is disclosed for wireless telecommunication infrastructures. The systems output requested locations of hand sets or mobile stations (MS) based on, eg, AMPS, NAMPS, CDMA or TDMA communication standards. The system determines both local MS locations...

Energy consumption in mobile phones: a measurement study and implications for network applications
N. Balasubramanian, A. Balasubramanian... - Proceedings of the 9th..., 2009 - dl.acm.org
In this paper, we present a measurement study of the energy consumption characteristics of three widespread mobile networking technologies: 3G, GSM, and WiFi. We find that 3G and GSM incur a high fall energy overhead because of lingering in high power states after...

After

[PDF] arxiv.org
[PDF] ustc.edu.cn
[PDF] ustc.edu.cn
[PDF] stonybrook.edu

Avoid broken PDF link in Google Scholar
Access Google Scholar both on and off campus

Open a new tab and links to NCKU E-Journal Gateway
Microsoft Academic search

Where does the data for Microsoft Academic come from?

MA uses machine readers powered by artificial intelligence (AI) to scan and extract knowledge from all scholarly publications discovered and indexed by Bing. Bing indexes data from a variety of sources ranging from publisher sites to individual authors’ personal homepages. MA’s AI agent then cleans and organizes these data into a graph database we call the Microsoft Academic Graph (MAG).

Showing semantic results matching "machine learning" 1-10 of 5000+ (0.258 seconds)

Sort by RELEVANCE

LIBSVM: A library for support vector machines
2011 ACM TRANSACTIONS ON INTELLIGENT SYSTEMS AND TECHNOLOGY
Chih-Chung Chang, Chih-Jen Lin
National Taiwan University

Support vector machine  □  Structured support vector machine  □  Sequential minimal optimization +7

LIBSVM is a library for Support Vector Machines (SVMs). We have been actively developing this package since the year 2000. The goal is to help users to easily apply SVM to their applications. LIBSVM has gained wide popularity in machine learning and many other areas. In this article, we present all ...

Download  Citations* (41,243)  Share  Cite

Relevance ranking sorts by default

Or search these topics analyzed by MAS

Find relationship between subject terms, topics.

Machine learning
Machine learning (ML) is the scientific study of algorithms and statistical models that computer systems use in order to perform a specific task effectively without using explicit instructions, relying on patterns and inferencing instead. It is a subfield of computer science.

Top Topics
- Machine learning
- Artificial intelligence
- Computer science
- Pattern recognition
- Computer vision
- Artificial neural network
- Mathematics
- Data mining
- Mathematical optimization
- Convolutional neural network

Parent topics
- Computer science

Child topics
- Artificial neural network
- Seasonality
- Regression analysis +97

Related topics
- Artificial intelligence
- Data mining
- Artificial neural network +17
Others

ResearchGate is a social networking site for scientists and researchers to share papers, ask and answer questions, and find collaborators.

[https://www.researchgate.net/](https://www.researchgate.net/)

Academia is a commercial social networking website for academics. The platform can be used to share papers and follow the research in a particular field.

[https://www.academia.edu/](https://www.academia.edu/)
Google Scholar
1. Setting Preferences for Library Full Text
   1) Setting
   2) Library Links
   3) Search “NCKU” and “National Cheng Kung University”

2. Search Google Scholar with research field keywords, check for any NCKU accessible results.

Microsoft Academic Search
https://academic.microsoft.com/home
1) Search MAS with research field keywords, find out field top authors and journals
2) Check for NCKU subscription for 1 of top journals which rank by MAS

*Using browser's incognito mode and DO NOT forget to logout personal account after practice.
Strongly recommend you to submit to Turnitin before the oral defense, originality reports can help you locate potential sources of plagiarism.

Any regulation about the value for similarity index?
① Not included yet from NCKU REGISTRAR DIVISION
② Please contact with the department/institute office about the value for similarity index.

High percentage of Similarity Scores, how do I update my thesis?
① Make the quote as short as possible
② Use quotation marks or block quote
③ Properly cite the source
④ Discuss with Advisor
Register, Submission..., please refer to “Turnitin Quick Start Guide”

Find Student Manual and other training materials here
E-Thesis Submission


Links

- Catalog
- Items
  - Requesting/Renewing
- Personal Data
- Open Hours
- E-Resources
- Media Online
- Library Instruction
  - Electronic Thesis
- Service Readers
- Space Management
- NDDS | RapidILL
- MetaCat+

**E-Thesis Submission**

Login with NCKU ID/PW

Submission workflow

- Guide to ETDS File Conversion and Service Workflow
  - NCKU Watermark-pdf
  - NCKU Watermark-jpg
- Checking notice before uploading PDF file
- Guidelines on Writing Dissertations for PhD and Master’s Students
- National Cheng Kung University Guideline for Collecting Digitalized Theses
- FAQ
Submitting your Thesis

Guide to ETDS File Conversion and Service Workflow

Guidelines on Writing Dissertations for PhD and Master’s Students

Covert your file in 1 PDF

Download licensed Adobe Acrobat (PDF editor) from NCKU computer center webpages

• Insert watermark
• Insert DOI address (Generate after filling in online thesis information)
• Document Properties Settings
  PDF file → File → Properties → Description
• Document Security Settings
  PDF file → File → Properties → Security

Upload Thesis (1 PDF file) to ETDS

Graduation Procedure

Unapproved:
Modify, please refer to suggestions in EMAIL replied

Approved:
Print out thesis

Submitting Thesis in paper:
M.S.: 1 paperback/paper cover to LIBRARY
1 paperback/paper cover to REGISTRAR DIVISION
PhD: 1 hardback/hard cover to LIBRARY
1 paperback/paper cover to REGISTRAR DIVISION

• Login "Online Application System for Graduation from NCKU"
• Printing out:
  1. Graduation Procedure Form
  2. (Print / Digital) Thesis & Dissertation Copyright License Agreement
     * Signature by student and advisor
     * Download via ETDS, or check approved EMAIL

Wait for Thesis format Check, Will inform students via EMAIL when approved or needing further modification

* DO NOT use free PDF editor.

Download licensed Adobe Acrobat (PDF editor) from NCKU computer center webpages

• Insert watermark
• Insert DOI address (Generate after filling in online thesis information)
• Document Properties Settings
  PDF file → File → Properties → Description
• Document Security Settings
  PDF file → File → Properties → Security

Upload Thesis (1 PDF file) to ETDS

Graduation Procedure

Unapproved:
Modify, please refer to suggestions in EMAIL replied

Approved:
Print out thesis

Submitting Thesis in paper:
M.S.: 1 paperback/paper cover to LIBRARY
1 paperback/paper cover to REGISTRAR DIVISION
PhD: 1 hardback/hard cover to LIBRARY
1 paperback/paper cover to REGISTRAR DIVISION

• Login "Online Application System for Graduation from NCKU"
• Printing out:
  1. Graduation Procedure Form
  2. (Print / Digital) Thesis & Dissertation Copyright License Agreement
     * Signature by student and advisor
     * Download via ETDS, or check approved EMAIL

Wait for Thesis format Check, Will inform students via EMAIL when approved or needing further modification

* DO NOT use free PDF editor.
You may need to provide screenshots (in .jpg) as attachment and describe your operating steps when using e-databases services or bibliographic software.

For bibliographic software questions, you may visit reference service desk in person with your laptop and original bibliographic file.

Reference service desk, 1F, Main Library
TEL: 06-2757575 ext. 65780, 65786
e-mail: libref@libmail.lib.ncku.edu.tw